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1  Overview
The information in this Readme file pertains to Novell® GroupWise® 7 Support Pack 4. This 
Support Pack contains updates for all components contained in the GroupWise 7 product. It includes 
the NetWare®, Linux*, and Windows* GroupWise 7 software. The NetWare and Windows software 
is provided in one set of downloads; the Linux software, including the Cross-Platform client for 
Linux and Macintosh*, is provided in a separate set of downloads. 

2  GroupWise System Requirements
The system requirements for GroupWise 7 Support Pack 4 are the same as those currently 
documented for GroupWise 7. Complete GroupWise system requirements are listed in the 
GroupWise 7 Installation Guide (http://www.novell.com/documentation/gw7/gw7_install/data/
bp8vh01.html#bp8vh01).

IMPORTANT: GroupWise system requirements do not apply to GroupWise Mobile Server. For 
GroupWise Mobile Server requirements, see the GroupWise Mobile Server Readme (http://
www.novell.com/documentation/gw7/gmsreadmeus/data/gmsreadmeus.html).

3  NetWare/Windows: Support Pack Installation
Section 3.1, “NetWare/Windows: Administration Software Installation Instructions,” on page 1
Section 3.2, “Windows: Client Software Installation Instructions,” on page 2

3.1  NetWare/Windows: Administration Software Installation 
Instructions

IMPORTANT: If you are installing the GroupWise software in a cluster, refer to the GroupWise 7 
Interoperability Guide (http://www.novell.com/documentation/gw7) for cluster-specific installation 
instructions before starting to install the Support Pack.

1 Download the NetWare/Windows GroupWise 7 SP4 compressed executable file to a temporary 
directory on your NetWare or Windows server:

gw704_full_nlmwin_us.zip for English only 
gw704_full_nlmwin_multi.zip for multilingual

2 Unzip the file into a directory at the root of your local drive or to a network server drive that 
can handle long pathnames.
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The compressed file contains directory paths that could exceed DOS limits.
3 In Windows, click Start > Run > Browse, then locate the directory where you extracted the SP4 

administration files.
4 Select the setup.exe file, then click OK to run the GroupWise Installation program.
5 Click Create or Update a GroupWise System.

During installation of a Support Pack, the GroupWise Installation program requests access to 
existing GroupWise software. You can provide the path to a software distribution directory or 
you can use your original GroupWise 7 media.

6 Follow the on-screen instructions to create the GroupWise 7 SP4 software distribution 
directory and install the administration and agent software.
Update the primary domain first. Start the MTA in the primary domain. Then update secondary 
domains, followed by the post offices in each domain. Start each MTA and POA for each 
domain and post office. Then update the other GroupWise agents.
For additional instructions, refer to the GroupWise 7 Installation Guide on the GroupWise 7 
Documentation Web site (http://www.novell.com/documentation/gw7).

3.2  Windows: Client Software Installation Instructions
1 Download the GroupWise 7 SP4 Windows Client compressed executable file to a temporary 

directory on your workstation:

gw704_client_win_us.zip for English only
gw704_client_win_multi.zip for multilingual

2 Unzip the file into a directory at the root of your local drive.
The compressed file contains directory paths that could exceed DOS limits.

3 In Windows, click Start > Run > Browse, then locate the directory where you extracted the SP4 
client files.

4 Select the setup.exe file, then click OK to run the GroupWise client Setup program.
5 Follow the on-screen instructions to install the SP4 client software on your workstation.

4  Linux: Support Pack Installation
Section 4.1, “Linux: Administration Software Installation Instructions,” on page 2
Section 4.2, “Linux: Cross-Platform Client Software Installation Instructions,” on page 3
Section 4.3, “Macintosh: Cross-Platform Client Software Installation Instructions,” on page 4

4.1  Linux: Administration Software Installation Instructions

IMPORTANT: If you are installing the GroupWise software in a cluster, refer to the GroupWise 7 
Interoperability Guide (http://www.novell.com/documentation/gw7) for cluster-specific installation 
instructions before starting to install the Support Pack.

1 Download the GroupWise 7 SP4 Administration compressed tar file to a temporary directory 
on your Linux server:
Wise 7 Support Pack 4
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gw704_full_linux_us.tar.gz for English only
gw704_full_linux_multi.tar.gz for multilingual

2 In a terminal window at your Linux server, change to the temporary directory, then use the 
following commands to uncompress and untar the downloaded file:
tar -xvzf filename.tar.gz

The files are extracted to the root of the directory.
3 Become root by entering sux and the root password.
4 Use the following command to start the GroupWise Installation program:

./install

5 Click Create or Update a GroupWise System.
6 Follow the on-screen instructions to create the GroupWise 7 SP4 software distribution 

directory and install the administration and agent software.
Update the primary domain first. Start the MTA in the primary domain. Then update secondary 
domains, followed by the post offices in each domain. Start each MTA and POA for each 
domain and post office. Then update the other GroupWise agents.
When you use the Linux GroupWise Installation program to install a Support Pack, use the 
Install option to install the updated RPM for each agent. Typically, you do not need to use the 
Configure option after installing updated agent software, if the agent configuration has not 
changed since the previous installation. (For an exception to this procedure, see Section 7.3.1, 
“Run Configure When Updating the Linux Agents,” on page 14). If you encounter a problem 
starting the updated agent, use the Configure option to update the configuration information.
For additional instructions, refer to the GroupWise 7 Installation Guide on the GroupWise 7 
Documentation Web site (http://www.novell.com/documentation/gw7).

4.2  Linux: Cross-Platform Client Software Installation 
Instructions

1 Download the GroupWise 7 SP4 Client compressed tar file to a temporary directory on your 
Linux workstation:

gw704_client_linux_us.tar.gz for English only
gw704_client_linux_multi.tar.gz for multilingual

2 In a terminal window at your Linux workstation, change to the temporary directory, then use 
the following command to uncompress and untar the downloaded file:
tar -xvzf filename.tar.gz

The files are extracted to the root of the directory.
3 Run the GroupWise Setup program to install the GroupWise Cross-Platform client software:

./install

4 To start the Cross-Platform client after installation, click the GroupWise icon on your Linux 
desktop.
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4.3  Macintosh: Cross-Platform Client Software Installation 
Instructions

1 Download the GroupWise 7 SP4 Client file to a temporary directory on your Macintosh 
workstation:

gw704_client_mac_ppc_us.dmg for English only, Mac OS* X
gw704_client_mac_ppc_multi.dmg for multilingual, Mac OS X
gw704_client_mac_intel_us.dmg for English only, Mac OS X on Intel*
gw704_client_mac_intel_multi.dmg for multilingual, Mac OS X on Intel

2 At your Macintosh workstation, browse to the file you downloaded.
3 Double-click the file to install the GroupWise Macintosh client.
4 To start the Cross-Platform client after installation, click the GroupWise icon on your 

Macintosh desktop.

5  Installation Issues
Section 5.1, “General Installation Issues,” on page 4
Section 5.2, “NetWare/Windows Installation Issues,” on page 5
Section 5.3, “Linux Installation Issues,” on page 5

Installation issues for individual GroupWise components are located under the heading for each 
component.

5.1  General Installation Issues
“Version Compatibility” on page 4
“GroupWise 7 Reinstallation” on page 5
“WebAccess and Monitor on the Same Web Server” on page 5
“Web Clipping Application (PQA) Support with WebAccess and Monitor” on page 5
“Additional Installation Issues” on page 5

5.1.1  Version Compatibility

If you install GroupWise on multiple platforms, or if you run multiple versions (for example, 
GroupWise 6.5 and GroupWise 7 in the same GroupWise system), refer to the GroupWise Version 
Compatibility section in the GroupWise 7 Installation Guide (http://www.novell.com/
documentation/gw7) to make sure that the combinations you are using are supported. 

For example, you cannot run a GroupWise 7 client against a GroupWise 6.5 or earlier post office. 
Earlier POAs cannot support later GroupWise clients. However, you can run a GroupWise 6.5 or 
earlier client against a GroupWise 7 POA.

Also, you cannot run the GroupWise 6.5 or earlier snap-ins to ConsoleOne® to access GroupWise 7 
databases or eDirectoryTM objects. You can use Admin Lockout Settings under Tools > GroupWise 
System Operations > System Preferences to specify the required version of the ConsoleOne snap-ins 
for each domain as needed.
Wise 7 Support Pack 4
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5.1.2  GroupWise 7 Reinstallation

If you install GroupWise 7 components from a software distribution directory located on your local 
drive or a network drive and then try to update those components by installing from a CD, the 
installation fails by erroneously prompting for a disk:

Please insert the disk: 1
Uninstall the existing software, then install from the CD.

5.1.3  WebAccess and Monitor on the Same Web Server

The WebAccess Application, WebPublisher Application, and Monitor Application share a common 
library. If you are updating from an earlier GroupWise version and if you run these applications on 
the same Web server, you must update all three before any of them can work properly.

5.1.4  Web Clipping Application (PQA) Support with WebAccess and Monitor

Palm OS* devices are no longer supported in GroupWise 7. However, the Installation program still 
offers the opportunity to configure this feature. If you have been using a PQA in an earlier version of 
GroupWise, you can continue to do so, but it is no longer a supported feature.

5.1.5  Additional Installation Issues

Platform-specific installation issues are listed in separate sections below. Installation issues for 
individual GroupWise components are located under the heading for each component.

5.2  NetWare/Windows Installation Issues
“Software Distribution Directory Dependency” on page 5
“Problem Installing from a Windows XP Service Pack 2 Machine” on page 5

5.2.1  Software Distribution Directory Dependency

When you create a new system and you are prompted for software to copy to the software 
distribution directory, select at least the agent and client software. The GroupWise Installation 
program launches the Agent Installation program and the Client Installation program. It currently 
must run those programs from the software distribution directory.

5.2.2  Problem Installing from a Windows XP Service Pack 2 Machine

When you install any GroupWise agent (Post Office Agent, Message Transfer Agent, Internet 
Agent, WebAccess Agent, Monitor Agent) to a NetWare server from a Windows XP machine where 
Service Pack 2 has been installed, you must have the Novell ClientTM 4.90 SP2 or later installed on 
the Windows machine. If you have an earlier Novell Client, the GroupWise Installation program 
claims that it cannot find some of the directories to which you want to install software.

5.3  Linux Installation Issues
“GroupWise Installation to a Xen Guest on SUSE Linux Enterprise Server 10” on page 6
“Linux Text-Based Installation Program Compatibility with ssh on Windows” on page 6
“Upgrading from an Incomplete Software Distribution Directory” on page 6
GroupWise 7 Support Pack 4 5
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“Moving a Library from NetWare or Windows to Linux” on page 6
“Moving a GroupWise 4.1 System from NetWare or Windows to Linux” on page 6

5.3.1  GroupWise Installation to a Xen Guest on SUSE Linux Enterprise Server 10

When you install GroupWise on SLES 10 to a Xen* guest, you might receive the following error 
message:

The current window is not large enough to run install. Please resize the window 
and run install again.

At present, the SLES 10 Xen console window does not report its dimensions properly. To work 
around this:

1 Make sure that SSH is enabled on the Xen guest.
2 Open an X terminal window on the SLES 10 Xen host by using the following command:

ssh -X root@guest_ip_address

3 Run the GroupWise Installation program from the Xen host.

5.3.2  Linux Text-Based Installation Program Compatibility with ssh on Windows

The text-based GroupWise Installation program does not run on all Windows versions of ssh. An 
open source product named PuTTY that can be downloaded from the Internet free of charge is 
compatible with the text-based GroupWise Installation program. There are several Web sites where 
PuTTY is available for download.

5.3.3  Upgrading from an Incomplete Software Distribution Directory

All GroupWise components on a server must be updated at the same time. Therefore, if you are 
installing GroupWise 7 from a software distribution directory that does not contain RPMs for all the 
components installed on the server, you receive the following error:

Install failed for an unknown reason (7)

The GroupWise 7 component cannot be updated because its RPM is not present in the software 
distribution directory. You can use the GroupWise 7 Administrator for Linux CD to update the 
server, then use Configure Administration to create a complete software distribution directory.

5.3.4  Moving a Library from NetWare or Windows to Linux

Issues related to uppercase letters and lowercase letters in directory names for libraries have been 
resolved, as described in TID 3697382: Document Management Case Change for GW7 SP3 in the 
Novell Support Knowledgebase (http://www.novell.com/support).

5.3.5  Moving a GroupWise 4.1 System from NetWare or Windows to Linux

The “Migrate” section of the GroupWise 7 Installation Guide provides instructions for moving from 
NetWare or Windows to Linux. If you are moving post offices and domains belonging to a 
GroupWise 4.1 system, you might need to manually rename the domain database (wpdomain.db) 
from uppercase to lowercase, along with all .dc files. In addition, subdirectories in post office and 
domain directories might need to be renamed to lowercase.
Wise 7 Support Pack 4
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6  Administration Issues
Section 6.1, “General Administration Issues,” on page 7
Section 6.2, “NetWare/Windows Administration Issues,” on page 9
Section 6.3, “Linux Administration Issues,” on page 11

6.1  General Administration Issues
“ConsoleOne Snap-In Version Compatibility” on page 7
“Text Version of Global Signatures” on page 7
“Images in Global Signatures” on page 8
“Global Signatures on Empty Messages” on page 8
“Global Signatures and Flat Forwarding through the Internet Agent” on page 8
“Priming Caching Mailboxes” on page 8
“-601 SPI Exception Displays during Alias Migration” on page 8
“Server Names” on page 8
“Identity Manager Version Compatibility” on page 9
“Identity Manager Configuration Issue” on page 9
“Server-Based Anti-Virus Software” on page 9

6.1.1  ConsoleOne Snap-In Version Compatibility

After a domain has been updated to GroupWise 7, do not administer that domain with earlier 
versions of the GroupWise snap-ins to ConsoleOne. Doing so could result in the unintentional 
creation of duplicate e-mail IDs. 

The e-mail ID indexing scheme has been changed to allow the same e-mail ID to be used in different 
Internet domains within the same GroupWise system. This was prevented by the previous indexing 
scheme. Because the check for uniqueness now works differently, you must use the GroupWise 7 
version of the ConsoleOne snap-ins when administering a GroupWise 7 domain to prevent the 
possibility of duplication.

6.1.2  Text Version of Global Signatures

In the original release of GroupWise 7, the text version of a global signature was generated 
automatically from the HTML version; you did not have any control over it. In GroupWise 7 
Support Packs, you can display and edit the text version as well as the HTML version. If you created 
global signatures in the original version of GroupWise 7, you should verify that the text version is 
what you want and modify it as needed. 

1 In ConsoleOne, click Tools > GroupWise System Operations > Global Signatures.
2 Select a global signature, then click Edit.
3 Modify the text version as needed.

For example, if the HTML version included an image, such as your company logo, you might 
want to add text to take the place of the image, such as the name of your company.
GroupWise 7 Support Pack 4 7
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4 Click OK to save your changes.
5 Repeat this procedure for each global signature.

6.1.3  Images in Global Signatures

You might encounter a problem including an image file in a global signature if the path to the image 
is too long. This is a Java* problem. The easiest workaround is to move the image to a location with 
a shorter path. Another solution on Windows is to set the TMP environment variable to c:\temp 
before starting ConsoleOne.

6.1.4  Global Signatures on Empty Messages

Global signatures are not added to empty messages. Users can create empty messages by filling in 
the Subject field but not providing a message body. They can also create empty messages by 
forwarding messages as attachments.

6.1.5  Global Signatures and Flat Forwarding through the Internet Agent

If you enable global signatures, it disables flat forwarding through the Internet Agent because the 
signature is appended to each message. As an administrator, you must choose which is more 
important in your GroupWise system, global signatures or flat forwarding.

6.1.6  Priming Caching Mailboxes

With the GroupWise 7.0.2 default POA settings, the POA starts 6 TCP handler threads, 20% of 
which are available for priming (only 1 thread). If a user tries to prime his or her Caching mailbox 
when that one thread is already busy, the user receives the message Server Busy. If the GroupWise 
administrator uses ConsoleOne to increase the number of TCP handler threads and the percentage 
allowed for priming, so that 2 or more threads are available, the POA goes through a polling cycle 
before the changes go into effect. Use the POA Web console to make sure that the changes are in 
effect before starting to prime a second Caching mailbox, or use the POA Web console to change 
settings. The settings are put into effect immediately when they are made from the POA Web 
console. 

For new POAs configured with GroupWise 7 SP3 and SP4, the POA starts 10 handler threads, 30% 
of which are available for priming (3 threads) to prevent this problem.

6.1.7  -601 SPI Exception Displays during Alias Migration

If the E-Mail Address field on the General page of a User object needs to be changed as a result of 
the information in the gateway alias, and if the User object cannot be found, a -601 SPI 
Exception displays and is written to the Alias Migration utility log file. This situation can arise 
when the association between the eDirectory object and the GroupWise object is broken for some 
reason. The association can be reestablished using Tools > GroupWise Utilities > GW / eDirectory 
Association > Associate Objects.

6.1.8  Server Names

When filling in a UNC Path field in ConsoleOne, you must specify the server name. You cannot use 
an IP address or DNS hostname.
Wise 7 Support Pack 4
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6.1.9  Identity Manager Version Compatibility

Do not run a DirXML® or Identity Manager driver earlier than version 2.1.3 against a GroupWise 7 
system. Version 2.2.1 or later is recommended. Older drivers are not compatible. You can download 
the latest version of the GroupWise driver from the Novell Identity Manager Patches Web site (http:/
/support.novell.com/filefinder/20560/index.html).

6.1.10  Identity Manager Configuration Issue

“Section 3.3.3: GroupWise WebAccess Templates” in the Identity Manager Accessory Portlet 
Reference Guide (http://www.novell.com/documentation/idm35/agprtlt/data/agprtltspartmail.html) 
provides information for configuring GroupWise portlets. In particular, it instructs you to edit lines 
in the webacc.cfg file to appear as follows:

Security.UseClientIP.enable=false
Security.UseClientCookie.enable=false

In addition to these changes in the webacc.cfg file, you need to make the following change in 
ConsoleOne:

1 Browse to and select the Domain object.
2 Right-click the GroupWiseWebAccess object, then click Properties.
3 Click Application > Security.
4 Deselect Use client IP in securing sessions, then click OK.

The Use client IP in security sessions setting defaults to selected (true). If you do not deselect it, the 
“true” setting is written to the webacc.cfg file, overwriting your manual change to that file. If this 
happens, the WebAccess client prompts for login multiple times.

6.1.11  Server-Based Anti-Virus Software

If you run server-based anti-virus software, you should configure it so that it does not scan 
GroupWise directory structures such as domains and post offices, where file locking conflicts can 
create problems for the GroupWise agents. If you need virus scanning on GroupWise data, check the 
GroupWise Partner Products page (http://www.novell.com/partnerguide/p100031.html) for 
compatible products.

6.2  NetWare/Windows Administration Issues
“Directory Names and Filenames” on page 10
“Novell Client File Caching” on page 10
“Unnecessary Login Prompt” on page 10
“GWTSA and Duplicate Source Directories” on page 10
“Quotas on NSS Volumes” on page 10
“TurboFat Compatibility” on page 11
“eDirectory Admin User Surname on Windows” on page 11
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6.2.1  Directory Names and Filenames

All directory names in paths to GroupWise domains and post offices can consist of up to 8 
characters. 

Filenames can also consist of up to 8 characters, with extensions of up to 3 characters. Do not use 
long filenames for any files used by any GroupWise components. This requirement applies even to 
files that are not specific to GroupWise (such as SSL certificates and key files).

6.2.2  Novell Client File Caching

When you run ConsoleOne, Novell Client file caching should be turned off to protect database 
integrity.

1 Right-click the red N in the notification area, then click Novell Client Properties.
2 Click Advanced Settings, select File Caching, then select Off.
3 Click OK to save your change.

6.2.3  Unnecessary Login Prompt

If you are running ConsoleOne 1.3.6f with JRE* 1.5 or if you are running ConsoleOne 1.3.6h, 
ConsoleOne might prompt you to log in when it tries to attach to the domain, even if you are already 
logged in to the server where the domain is located. Click Cancel to close the two unnecessary 
dialog boxes. 

If you try to log in using these unnecessary prompts, you receive the following error:

NMAS: bad request syntax error - 1632 (0xffff9a0)

6.2.4  GWTSA and Duplicate Source Directories

The GroupWise Target Service Agent (GWTSA) handles situations where the same directory names 
are used for backups on different volumes by numbering the instances. For example:

Original GWTSA 
GroupWise System/[Dom]Provo2:
GroupWise System/[Dom]Provo2:

Support Pack GWTSA 
GroupWise System/1[DOM]Provo2:
GroupWise System/2[DOM]Provo2:

Each instance is numbered and DOM is in all uppercase letters. After updating the GWTSA with 
GroupWise 6.5 Support Pack 1 or later, you must re-create your backup jobs because the path has 
changed.

6.2.5  Quotas on NSS Volumes

If you use NSS volumes with quotas turned on, then you must turn on quotas on all GroupWise 
directories. Otherwise, you will receive No Disk Space errors.
Wise 7 Support Pack 4
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6.2.6  TurboFat Compatibility

If you see E811 errors on the POA or the GroupWise client, a possible cause is that TurboFat is 
corrupting GroupWise database pointers. The solution is to turn off TurboFat.

To turn off TurboFat on NetWare 5.x servers, use turbodis.nlm.
To turn off TurboFat on NetWare 6.x servers, use tdis600.nlm.

These NLMTM programs disable TurboFat at startup.

6.2.7  eDirectory Admin User Surname on Windows

When you create a new eDirectory tree on Windows, the surname of the Admin user is 
automatically set to a single space. This can cause problem in some GroupWise situations. For best 
results, manually set the surname of the Admin user to something meaningful.

6.3  Linux Administration Issues
“NFS Not Supported” on page 11
“Pathnames and Filenames in Lowercase” on page 11
“eDirectory Admin User Surname on Linux” on page 11
“Unavailable Administration Features” on page 11

6.3.1  NFS Not Supported

Because of long-standing file lock issues with NFS*, you cannot use an NFS mount to mount a 
server file system where your GroupWise system is located to a workstation where you are running 
ConsoleOne. We recommend using an SMB mount instead.

6.3.2  Pathnames and Filenames in Lowercase

All directory names in paths to GroupWise domains and post offices should consist of lowercase 
letters. Filenames should also consist of lowercase letters. There are no length restrictions.

6.3.3  eDirectory Admin User Surname on Linux

When you create a new eDirectory tree on Linux, the surname of the Admin user is automatically set 
to a single space. This can cause problem in some GroupWise situations. For best results, manually 
set the surname of the Admin user to something meaningful.

6.3.4  Unavailable Administration Features

GroupWise 7 administration on Linux does not include the following features that are available in 
GroupWise 7 on NetWare and Windows:

Import/Export utility in ConsoleOne
Document Properties Management feature in ConsoleOne

7  Agent Issues
Section 7.1, “General Agent Issues,” on page 12
GroupWise 7 Support Pack 4 11
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Section 7.2, “NetWare/Windows Agent Issues,” on page 13
Section 7.3, “Linux Agent Issues,” on page 14

7.1  General Agent Issues
“Agent Web Console Functionality in Firefox” on page 12
“New View Files Now Overwrite Existing View Files” on page 12
“POA Indexing Limitations” on page 12
“SOAP Port Number Not Replicated by the Original GroupWise 7 ConsoleOne Administrator 
Snap-In” on page 12
“Evolution Compatibility with the POA and SOAP” on page 13
“MTA /tcptrunkwidth Switch Is Obsolete” on page 13

7.1.1  Agent Web Console Functionality in Firefox

On the Links page of the MTA Web console in Firefox*, previous versions had a problem with the 
functionality of the Suspend and Resume buttons. Support Pack 2 or later resolves the problem. 
However, some browser settings need to be cleared in order for the fix to take effect. 

In Firefox:

1 Click Tools > Options.
2 Click Privacy, then click Settings.
3 Select Clear private data when closing Firefox, then click OK twice.
4 Exit Firefox, then start Firefox again.

7.1.2  New View Files Now Overwrite Existing View Files

When you update the POA software, updated view files are copied to the software distribution 
directory but not to post offices. This maintains any customizations you might have made in the 
view files. When you use the Refresh Views option under Tools > GroupWise Utilities > System 
Maintenance in ConsoleOne, the post office view files are updated from the software distribution 
directory. If you have created custom view files with the same names as standard view files, you 
must create backup copies so that your customized view files are not lost in the refresh process. 
After you refresh the views, you must restore your customized view files to the post office.

7.1.3  POA Indexing Limitations

The POA’s QuickFinderTM indexing feature does not currently index PDF files or OpenOffice files.

7.1.4  SOAP Port Number Not Replicated by the Original GroupWise 7 ConsoleOne 
Administrator Snap-In

If you enabled SOAP in the original GroupWise 7 release, and if you changed the SOAP port 
number from its default of 7191, this information was not correctly replicated from the domain 
database to which ConsoleOne was attached to the post office database used by the POA for its 
configuration information. As a result, SOAP e-mail clients that relied on POA redirection 
(ngwnameserver) were not able to connect to the proper POA unless the correct IP address and port 
number were provided when starting the client.
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In later GroupWise 7 Support Packs, successful POA redirection is critical to proper functioning of 
GroupWise Mobile Server. If you enabled SOAP in GroupWise 7 and changed the port number, you 
need to force the port number to replicate from the domain database to the post office database. 

1 Install the GroupWise Administrator snap-in to ConsoleOne from the Support Pack.
2 In ConsoleOne, browse to and right-click the POA object.
3 Click GroupWise > Agent Settings.
4 Deselect Enable SOAP, then click Apply.
5 Select Enable SOAP, then click OK.
6 Repeat this procedure for each POA in your GroupWise system.

By manually modifying the SOAP information, the SOAP information, including the port number, 
is written to the domain database and then properly replicated to the post office database so that 
redirection works properly for SOAP clients.

7.1.5  Evolution Compatibility with the POA and SOAP

Users might experience problems using EvolutionTM to connect to their GroupWise mailboxes if they 
are using Evolution 2.6.0 or earlier. In addition, earlier versions of Evolution can cause high 
utilization on GroupWise servers. To encourage users to update to the latest version of Evolution, 
you can use the /evocontrol switch in the POA startup file to configure the POA to allow only 
specified versions of Evolution. The /evocontrol switch takes either of the following parameters:

/evocontrol-"Evolution-1.10-yyyy-mm-dd"
/evocontrol-"Evolution-Data-Server-1.10-yyyy-mm-dd"

You can put up to 10 switch entries in the startup file, so that you can list as many as 10 versions of 
Evolution. Entries beyond 10 are ignored. You can view the current entries at the POA Web console 
with the other SOAP settings. The POA log file lists the settings in the Soap Session section.

7.1.6  MTA /tcptrunkwidth Switch Is Obsolete

Earlier versions of GroupWise and the default MTA startup file included the /tcptrunkwidth switch. 
This switch has not been functional for several releases and has not been included in the product 
documentation. If you have been using the /tcptrunkwidth switch in the MTA startup file, you 
should remove it. It is no longer performing the function that it did in earlier versions because the 
MTA now handles the trunk width tuning automatically.

7.2  NetWare/Windows Agent Issues
“Potential CAP Port Conflict” on page 13

7.2.1  Potential CAP Port Conflict

By default, the POA uses 1026 for its CAP (Calendar Access Protocol) port. On some Windows 
2000 servers, port 1026 is already used by the Windows Task Scheduler or other Windows service. 
If this occurs, configure the POA to use a different CAP port by using the /capport switch in the 
POA startup file.
GroupWise 7 Support Pack 4 13
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7.3  Linux Agent Issues
“Run Configure When Updating the Linux Agents” on page 14
“Linux Agents Not Starting Automatically” on page 14
“Non-root Agents on Open Enterprise Server for Linux Support Pack 2” on page 14
“Handling GroupWise Agent Core Files on Linux Servers” on page 14
“POA SOAP Protocol on Open Enterprise Server for Linux” on page 14
“libXm.so.3 Error” on page 15

7.3.1  Run Configure When Updating the Linux Agents

Normally, when you update your agent software with a Support Pack, you can use the Install Agents 
option in the GroupWise Installation program to install the updated agent software, but you do not 
need to use the Configure Agents option because your agents are already configured. However, in 
GroupWise 7 Support Packs, you should use Configure Agents after updating the agent software in 
order to obtain the updated grpwise script.

7.3.2  Linux Agents Not Starting Automatically

Under certain circumstances, the Linux agents to do not start automatically at system startup, even 
though you selected Launch GroupWise Agents on System Startup during installation. Use the 
following commands as root to correct the problem:

chkconfig grpwise off
chkconfig grpwise on

7.3.3  Non-root Agents on Open Enterprise Server for Linux Support Pack 2

On Novell Open Enterprise Server SP2, services such as IMAP and IMAP SSL, which require port 
numbers below 1025, cannot be initiated or restarted after the GroupWise agents are running as a 
non-root user. To initiate or restart those services, you must manually stop the services and then 
restart the GroupWise agents.

This also applies to SUSE® Linux Enterprise Server 9 SP3, the version of SLES that is bundled with 
Open Enterprise Server SP2.

7.3.4  Handling GroupWise Agent Core Files on Linux Servers

When the POA, the MTA, or the Internet Agent starts, it creates a file named process_id.pid in 
the same directory where log files for the agent are created. The process_id.pid file includes the 
build date of the agent that created the core file. When a GroupWise agent creates a core file, it is 
always named core.process_id. If you need to submit a core file to Novell Support, please 
include the corresponding process_id.pid file so that Novell Support can determine the specific 
agent build that created the core file. Old process_id.pid files can be manually deleted along with 
their corresponding core files.

7.3.5  POA SOAP Protocol on Open Enterprise Server for Linux

On OES Linux SP1, the Linux POA does not currently support the SOAP protocol when running as 
a non-root user. However, it does support the SOAP protocol when running as root. 
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On OES Linux SP2, the Linux POA does support the SOAP protocol when running as a non-root 
user, as well as when running as root.

7.3.6  libXm.so.3 Error

If you try to start the Linux POA or MTA using the --show switch on a server where The X Window 
System* and Open Motif* are not running, you receive the following error:

libXm.so.3: cannot open shared object file
: no such file or directory

To resolve the error, start The X Window System and Open Motif before starting the POA or MTA 
with the --show switch. If you start the POA or MTA without the --show switch, you can use the 
agent’s Web console to monitor the agent from your Web browser.

8  Client Issues
Section 8.1, “Client Shared Folder Security Issue,” on page 15
Section 8.2, “Windows Client Issues,” on page 15
Section 8.3, “Cross-Platform Client Issues,” on page 18
Section 8.4, “Outlook Connector Issues,” on page 19

8.1  Client Shared Folder Security Issue
A security vulnerability exists in the GroupWise Windows Client API that can allow programmatic 
access to non-authorized e-mail under certain conditions. The attacker must first authenticate to 
GroupWise and be a recipient of a shared folder from another user. The attacker could then exploit 
the vulnerability to gain unauthorized access to non-shared e-mail in the mailbox of the sharer.

Users who have shared folders with other users can protect their e-mail by removing shared access 
until remedial steps have been completed. It is not necessary to delete the contents of the shared 
folders, and folders can be re-shared after the administrator has locked out older client versions. To 
remove shared access to a folder, select the shared folder, click File > Sharing, select Not Shared, 
then click OK.

Administrators should lock out earlier versions of the GroupWise client in ConsoleOne in post 
offices where shared folders are in use.

1 Right-click each Post Office object, then click Properties.
2 Click GroupWise > Client Access Settings. 
3 Select Minimum Client Release Version, specify 7.0.4, then click OK.
4 Repeat this procedure for each post office in your GroupWise system where shared folders are 

in use.

If you are running a mixed environment of GroupWise 6.5 and 7 clients, base the lockout on the 
client release date rather than the client version. The recommended release date should be 9 Mar 
2008 in order to ensure that your system is not vulnerable.

8.2  Windows Client Issues
“Error Messages When You Install GroupWise Windows Client” on page 16
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“Windows XP Service Pack 2” on page 16
“Windows XP and Administrator Users” on page 16
“Missing Global Signatures on Empty Messages” on page 17
“Limited iCal Interoperability with External Systems” on page 17
“Can’t Set a Primary Archive Computer” on page 17
“Can’t Administer Distribution Lists in Caching Mode” on page 17
“Screen Flickers When Scrolling a Message” on page 17
“Can’t Switch Modes When Using Microsoft Anti-Spyware” on page 17
“Address Books Do Not Display in GroupWise When Installing GroupWise After Outlook 
2003” on page 17
“Notify Alarms Disappear for Appointments” on page 17
“Updated JAWS Script Available” on page 18
“Spyware Detection Software Causes Installation to Not Work” on page 18
“VMware and Proxy” on page 18

8.2.1  Error Messages When You Install GroupWise Windows Client 

If you install the GroupWise Windows client with Outlook* XP already installed, an error message 
appears:

Either there is no default mail client or the current mail client cannot fulfil 
the messaging request. 
Please run Microsoft Outlook and set it as the default mail client.

In addition, if you open the Address Book, the GroupWise client crashes.

To fix the problem, run win32\wms\nt\us\wms.exe from the GroupWise installation directory, 
then restart the client.

8.2.2  Windows XP Service Pack 2

Installing Windows XP Service Pack 2 enables the Windows Firewall by default. The default 
Windows Firewall configuration blocks UDP (User Datagram Protocol). GroupWise is dependent 
on UDP for several key features such as listing new messages in your Mailbox, displaying 
notifications, and performing Busy Searches. To reconfigure the Windows Firewall so that it does 
not interfere with GroupWise functionality, follow the instructions in TID 10094089 in the Novell 
Support Knowledgebase (http://www.novell.com/support/supportcentral).

8.2.3  Windows XP and Administrator Users

If GroupWise 7 has already been installed on a workstation by an administrator user, and if a 
GroupWise 7 Support Pack is installed by a different administrator user, a second instance of 
GroupWise is installed and the first instance is not updated. To fix this problem, go to the Control 
Panel, then double-click Add/Remove programs. If GroupWise is listed twice, remove the obsolete 
instance.
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8.2.4  Missing Global Signatures on Empty Messages

If you send a message with a subject only (no message body), a global signature is not appended. 
This is working as designed. The presence of a global signature on a message with an empty 
message body would prevent the Internet Agent /flatfwd switch from functioning correctly. 

8.2.5  Limited iCal Interoperability with External Systems

GroupWise might not handle iCal attachments correctly if they are received from a non-GroupWise 
external system. 

In particular, iCal appointments sent from non-GroupWise external systems (except Microsoft* 
Exchange) display as all-day appointments instead of All Day Events. Because of this, such 
appointments display in the Appointment pane instead of the All-Day-Events pane.

8.2.6  Can’t Set a Primary Archive Computer

Currently there is no way to set one computer as a primary archive. This can result in multiple 
archives if you use GroupWise on different computers.

8.2.7  Can’t Administer Distribution Lists in Caching Mode

In Online mode, if you have been granted rights to modify a distribution list, you can edit that 
distribution list in the GroupWise Address Book. In Caching mode, you cannot edit the distribution 
list in the GroupWise Address Book. However, if you go into the Address Selector in a new 
message, you can administer the distribution list from there.

8.2.8  Screen Flickers When Scrolling a Message

If you use ClearType to smooth the edges of screen fonts and have an LCD display, your screen 
might flicker when scrolling in a text message.

8.2.9  Can’t Switch Modes When Using Microsoft Anti-Spyware

If you are using Microsoft’s Anti-Spyware software, and you try to switch modes, GroupWise does 
not close. You must manually close GroupWise to switch modes. 

8.2.10  Address Books Do Not Display in GroupWise When Installing GroupWise 
After Outlook 2003

The address books do not display in GroupWise if you install GroupWise for the first time after you 
have installed Outlook 2003. To resolve the problem, uninstall Outlook 2003 before you install 
GroupWise for the first time.

8.2.11  Notify Alarms Disappear for Appointments

After your account has been moved from one post office to another, your Notify alarms disappear 
for appointments. To get your Notify alarms back, you need to re-create all the alarms manually. For 
information on setting alarms for appointments, see the GroupWise client help.
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8.2.12  Updated JAWS Script Available

Users of the JAWS* screen reader should install the new JAWS script available in GroupWise 7. 
Follow the instructions in the \client\jaws\gw_jaws_readme.txt file to install the JAWS script 
and other files on your workstation. This JAWS script includes Section 508 accessibility bug fixes 
that have occurred since the script was updated for GroupWise 6.5 Support Pack 3.

8.2.13  Spyware Detection Software Causes Installation to Not Work

If you have spyware detection software installed on your Windows computer, the GroupWise client 
for Windows might not install properly. Disable the spyware detection software before you install 
the GroupWise client for Windows.

8.2.14  VMware and Proxy

If you run the GroupWise Windows client in a VMware* virtual machine, you might receive an 
8503 error when you try to proxy to another user’s mailbox or display a Multi-User Calendar. To 
eliminate this problem, you need to disable the VMware adapters on your Windows workstation.

1 Right-click My Network Places, then click Properties.
In the list of LAN connections, you see one or more VMware adapters.

2 Right-click each adapter, then click Disable.

8.3  Cross-Platform Client Issues
“Items Forwarded from the GroupWise Connector for Outlook Do Not Open” on page 18
“Running as root in Caching Mode” on page 18
“Mailbox Size Limits Not Recognized” on page 19
“Bold Not Displaying on Macintosh” on page 19
“Archiving Over the Network” on page 19
“No Progress Bar Displayed When a Database Is Rebuilt” on page 19
“Focus Is in the Wrong Place When Creating a Reply on Macintosh” on page 19
“WebRenderer Not Available on Mac OS X on Intel” on page 19

8.3.1  Items Forwarded from the GroupWise Connector for Outlook Do Not Open

If you receive an item that was forwarded from the GroupWise Connector for Outlook, the item does 
not open in the Macintosh version of the Cross-Platform client.

8.3.2  Running as root in Caching Mode

If you run the Cross-Platform client in Caching mode as root on Linux, you might encounter 
synchronization problems with your master mailbox when you next run as a regular user. If pending 
requests from the root session remain when you log in as a regular user, regular user requests get 
backed up behind the root requests, which cannot be processed while you are logged in as a regular 
user. To resolve any problems, run the client as root again so that all messages are synchronized, 
then run as a regular user thereafter to prevent further problems.
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8.3.3  Mailbox Size Limits Not Recognized

The Cross-Platform client does not recognize the mailbox size limits set in ConsoleOne (Tools > 
GroupWise Utilities > Client Options > Send > Disk Space Management).

8.3.4  Bold Not Displaying on Macintosh

If you have installed Microsoft Office or Internet Explorer on your Macintosh, new messages might 
not display as bold in your mailbox. To resolve the problem, disable your user fonts, which are 
typically duplicates of your system fonts, or update to JVM* 1.4.2 Update 1 or later.

8.3.5  Archiving Over the Network

Archiving with the Cross-Platform client can only be done to your local computer hard drive. 

8.3.6  No Progress Bar Displayed When a Database Is Rebuilt

When prompted to rebuild your database, there is no progress indicator displayed during the rebuild 
process.

8.3.7  Focus Is in the Wrong Place When Creating a Reply on Macintosh

When you click Reply on Macintosh, you cannot just type the message. You must move the mouse 
cursor to the message body window of the reply message before you can start typing. 

8.3.8  WebRenderer Not Available on Mac OS X on Intel

The improved rendering of HTML in the WebAccess client is not available on Mac OS X on Intel 
because the WebRenderer* product that has been incorporated into GroupWise is not yet available 
for Mac OS X on Intel.

8.4  Outlook Connector Issues
“Outlook 2007 Compatibility” on page 19

8.4.1  Outlook 2007 Compatibility

The GroupWise 7 Connector for Microsoft Outlook cannot be installed with Outlook 2007. If you 
run the Outlook Connector Setup program in this environment, you receive the following message:

A version of Outlook compatible with the GroupWise Connector cannot be found. 
Install Outlook and run this install again.

The Outlook Connector is not supported with Outlook 2007.

9  WebAccess Issues
Section 9.1, “General WebAccess Issues,” on page 20
Section 9.2, “NetWare/Windows WebAccess Issues,” on page 23
Section 9.3, “Linux WebAccess Issues,” on page 27
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9.1  General WebAccess Issues
“GroupWise 7.0.3 WebAccess Compatibility with Earlier Versions of WebAccess” on page 20
“WebAccess Compatibility with Virtual Office 1.5 and Earlier” on page 20
“WebAccess Compatibility with Novell exteNd” on page 20
“Browser Cache Issue” on page 21
“Login Page Reappears after a Successful Login” on page 21
““Login Is Not Current” Error” on page 21
“Pop-Up Blocker Issue” on page 21
“Recommendation for Tomcat Memory Allocation (Heap Size)” on page 22
“Preventing Web Server Directory Browsing” on page 22
“Preventing Unauthenticated Template Access” on page 22
“Updates to WebAccess Templates” on page 22
“GroupWise 6.5 Frame Templates No Longer Supported” on page 23
““The Page Cannot Be Displayed” Error” on page 23
“Blank WebAccess Address Book on Internet Explorer” on page 23
“Document Viewer Agent Cache Compatibility” on page 23
“Document Viewer Agent /template Switch” on page 23

9.1.1  GroupWise 7.0.3 WebAccess Compatibility with Earlier Versions of WebAccess

Before GroupWise 7.0.3, you could successfully run different versions of the WebAccess Agent and 
the WebAccess Application together. For example, you could install a new version of the 
WebAccess Application on your Web server while still running the previous version of the 
WebAccess Agent for the domain. 

Starting in GroupWise 7.0.3, the recommended update procedure is to update all the WebAccess 
Agents in your GroupWise system first, then update all the WebAccess Applications. Long-term use 
of the mixed-version configuration is not recommended. You must update both the WebAccess 
Agent and the WebAccess Application to the same version in order to ensure proper functioning of 
the GroupWise 7.0.3 WebAccess client.

Running a new WebAccess Application with an older WebAccess Agent is no longer supported.

9.1.2  WebAccess Compatibility with Virtual Office 1.5 and Earlier

If you access the WebAccess client through Virtual Office 1.5 or earlier, you might see the old 
WebAccess client interface rather than the new one. To resolve this problem, see TID 10098412 in 
the Novell Support Knowledgebase (http://www.novell.com/support/supportcentral).

9.1.3  WebAccess Compatibility with Novell exteNd

Before GroupWise 7, WebAccess stored its default user interface files in the following directory on 
the Web server:

tomcat_root/webapps/gw/WEB-INF/classes/com/novell/webaccess/
                                                      templates/frames
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In GroupWise 7, the user interface files are stored in the css subdirectory of templates rather than 
the frames subdirectory.

If you have exteNdTM portlets configured to use WebAccess, you must copy some of the exteNd 
template files from the frames directory into the css directory. Refer to the Novell exteNd 
documentation (http://www.novell.com/documentation/extend5) to determine which exteNd 
template files you should copy to the css directory. 

IMPORTANT: Do not copy the entire contents of the frames directory into the css directory; this 
damages the new GroupWise 7 WebAccess user interface.

In addition, modify the WebAccess URL in the exteNd Portal Preferences from:

http://Web_server_address/servlet/webacc

to:

http://Web_server_address/gw/webacc

9.1.4  Browser Cache Issue

After the WebAccess software has been updated, users’ browsers might pull old WebAccess files 
from the local cache rather than using the updated files that have just been installed. The results are 
unpredictable, including not being able to compose an item, reply, and so on. To resolve such 
problems, users need to clear the browser cache and then log in to the WebAccess client again.

9.1.5  Login Page Reappears after a Successful Login

If the WebAccess login page appears in one or more of the frames (for example, the Folder list or the 
Item list) after a WebAccess user has successfully logged in, the user is probably accessing 
WebAccess through one or more proxy servers.

To prevent this problem:

1 In ConsoleOne, right-click the WebAccess Application object (GroupWiseWebAccess), then 
click Properties.

2 Click Application > Security, then deselect Use Client IP in Securing Sessions. 
For information about this option, click Help on the Environment page.

3 Click OK to save the change.

9.1.6  “Login Is Not Current” Error

If you are already logged in to the WebAccess client and you try to log in again without logging out 
first, you receive the “Login In Not Current” error. This is working as designed for security 
reasons.

9.1.7  Pop-Up Blocker Issue

Very occasionally, a pop-up blocker can prevent you from opening messages in the WebAccess 
client. If this happens, you can turn off the pop-up blocker or use a different one. Many pop-up 
blockers are available.
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9.1.8  Recommendation for Tomcat Memory Allocation (Heap Size)

If you are using the Tomcat servlet engine with GroupWise WebAccess, the maximum memory 
allocation (heap size) for Tomcat should be at least 128 MB. The maximum memory allocation is set 
by using the -Xmx parameter when starting Tomcat (for example, -Xmx128m).

9.1.9  Preventing Web Server Directory Browsing

If your Web server is configured to allow directory browsing, it is possible for a user to access the /
com directory of your Web server and browse downward from there. There is no confidential 
information located in any of the directories that are accessible in this manner. 

However, if you want to prevent access, you can change the configuration of your Web server. For 
example, if you are using Apache*, you can modify the httpd.conf file to remove the access that 
is provided by default. Locate the section that provides directory options for the htdocs directory. 
Either remove the Indexes option from the Options directive or place a minus (-) in front of it. 
Restart Apache to put the change into effect.

9.1.10  Preventing Unauthenticated Template Access

Under certain very specific circumstances, it is possible for a user to view WebAccess template files 
from a Web browser without logging in to WebAccess. There is no confidential information located 
in any of the template files that are accessible in this manner. 

Starting with GroupWise 6.5 Support Pack 4, a line was added to the webacc.cfg file to prevent 
such access:

Templates.requireAuthentication=true

With this setting, unauthenticated users have no access to any WebAccess template files except for 
the Login page. If you have customized WebAccess templates for your own specialized use, this 
setting causes your templates to be inaccessible, even if GroupWise authentication was not 
previously required. You can turn off the authentication requirement by changing the line in the 
webacc.cfg file to:

Templates.requireAuthentication=false

9.1.11  Updates to WebAccess Templates

If you have created your own customized versions of the WebAccess send.inc and msgitem.htt 
templates, you need to make the following changes to these files in order for them to be compatible 
with GroupWise 7:

Do not use the Url.Item.Reply.to and Url.Item.Reply.cc variables to pass and post names in a 
reply message’s To and CC fields. Instead, use Item.toFullID and Item.ccFullID (or 
Item.toName or Item.ccName).
When issuing an Item.Read action for a reply, set the Item.Reply parameter to either “sender” 
(to reply only to the sender) or “all” (to reply to all).
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9.1.12  GroupWise 6.5 Frame Templates No Longer Supported

In GroupWise 7, the GroupWise 6.5 frame template files were still included in the GroupWise 7 
software image. Some users for whom the GroupWise 7 WebAccess client performance was 
unacceptably slow returned to using the GroupWise 6.5 frame template files in their GroupWise 7 
WebAccess installations.

Because the performance issues in the WebAccess client have been resolved in GroupWise 7 
Support Packs, the Installation program does the following when you install the WebAccess 7 
software from a Support Pack over the original GroupWise 7 software:

Deletes the frames entry from the user interfaces list (ConsoleOne > WebAccess Application 
object > Application > Templates > Define User Interfaces). 
Resets the default user interface to Standard HTML by using the css templates.
Moves the GroupWise 6.5 template files into a backup directory.
Installs the new css template files to the templates directory of your Web server.

If you were using the GroupWise 6.5 frame templates with your GroupWise 7 installation, please do 
not continue to do so.

9.1.13  “The Page Cannot Be Displayed” Error

On older versions of Internet Explorer*, users might receive this message after the WebAccess 
software has been updated. See TID 10081268 in the Novell Support Knowledgebase (http://
www.novell.com/support/supportcentral) for instructions to correct the problem. Update to the latest 
version of Internet Explorer to avoid the problem.

9.1.14  Blank WebAccess Address Book on Internet Explorer

On Internet Explorer, when you exit from Address Book Options in the WebAccess Address book, 
the Address Book page might be blank. Press F5 (Refresh) to redisplay the Address Book.

9.1.15  Document Viewer Agent Cache Compatibility

The cache created by the Document Viewer Agent is not compatible with the cache previously used 
with WebPublisher. Old WebPublisher cache directories should be removed from servers where the 
Viewer Agent is installed.

9.1.16  Document Viewer Agent /template Switch

The Document Viewer Agent startup file (gwdva.dva) lists a /template startup switch that is not yet 
implemented.

9.2  NetWare/Windows WebAccess Issues
“WebAccess Installation Error on Windows Workstations” on page 24
“WebAccess Service Fails to Start on Windows Servers” on page 24
“Novell iManager Compatibility on Windows” on page 24
“WebAccess Stops Responding on NetWare” on page 24
“GroupWise 6.5 Upgrade on NetWare” on page 24
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“New NetWare and Windows WebAccess URLs” on page 24
“Web Server File Cleanup Because of a URL Change” on page 26
“Problem Downloading Large Attachments” on page 26
“Memory Problem” on page 26
“Security Issue with WebAccess and Internet Explorer 5.0” on page 27
“Viewer Agent Issues on NetWare” on page 27

9.2.1  WebAccess Installation Error on Windows Workstations

If you receive an error during installation indicating that the nvweb.dll file cannot be found, update 
the workstation to the latest Novell Client. The Novell Client is available for download from the 
Novell Downloads Web site (http://download.novell.com).

9.2.2  WebAccess Service Fails to Start on Windows Servers

If you install the WebAccess Agent as a Windows service, reboot the server, and then do a 
workstation login as an Administrator, the WebAccess Agent service might fail to start. If this 
occurs, update to the latest Novell Client. The Novell Client is available for download from the 
Novell Downloads Web site (http://download.novell.com).

9.2.3  Novell iManager Compatibility on Windows

If WebAccess and Novell iManager are installed on the same Windows 2000/2003 server, iManager 
might stop working. Because WebAccess installs and configures its own Tomcat and Jakarta 
connector, it is preferable to install it on a server where Tomcat is not already in use by another 
program.

9.2.4  WebAccess Stops Responding on NetWare

WebAccess might stop responding for a period of time on NetWare. It might or might not resume 
operation. To resolve this problem, update to the latest Winsock patch available on the Novell 
Downloads site (http://download.novell.com).

9.2.5  GroupWise 6.5 Upgrade on NetWare

If the GroupWise 6.5 WebAccess Application is running on the server where you plan to install 
GroupWise 7 WebAccess, you should manually stop WebAccess, the Web server, and Tomcat before 
starting the GroupWise 7 installation. Under certain circumstances, the WebAccess Installation 
program cannot stop them for you.

9.2.6  New NetWare and Windows WebAccess URLs

Existing users of WebAccess are accustomed to accessing the following URLs on NetWare and 
Windows Web servers:

Web Services page: Default index.html file of the Web server

WebAccess: http://web_server_address/servlet/webacc

WebPublisher: http://web_server_address/servlet/webpub
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The WebAccess URLs on NetWare and Windows Web servers are now the same as the URLs used 
on Linux:

To keep users’ browser bookmarks from being broken, you should redirect the old URLs to the new 
URLs. Follow the instructions below for your Web server.

Apache

1 Change to the conf subdirectory of the Apache root directory (for example, \apache2\conf.
2 Edit the Apache configuration file for GroupWise.

On NetWare 6, the Apache configuration file is gwapache.conf. On NetWare 6.5, the Apache 
configuration file is gwapache2.conf.

3 Add the following line:
redirect permanent /servlet/webacc http://web_server_address/
                                                            gw/webacc 

4 If you use WebPublisher, add the following additional line:
redirect permanent /servlet/webpub http://web_server_address/
                                                            gw/webpub 

5 Save the file, then exit the editor.
6 Restart Apache to put the redirections into effect.

Internet Information Server (IIS)

1 Change to the inetpub\wwwroot subdirectory of the IIS root directory (for example, 
c:\inetpub\wwwroot)

2 Create a subdirectory named servlet.
3 Under the servlet subdirectory, create a subdirectory named webacc.
4 If you use WebPublisher, create a second subdirectory named webpub.
5 In IIS Manager, expand the tree in the left pane to display Default Web Site under Web Sites.

Under Default Web Sites, you should see the servlet subdirectory you created in Step 2.
6 Expand the servlet subdirectory to display the webacc subdirectory (and optionally, the 

webpub subdirectory) that you created in Step 3.
7 Right-click the webacc subdirectory, then click Properties.
8 Click Directory, select A Redirection to a URL, then type /gw/webacc in the associated field.
9 Select A Permanent Redirection for This Resource, then click OK to save your changes.

10 If you use WebPublisher, repeat Step 7 through Step 9, using webpub in place of webacc.
11 Restart the IIS Web server to put the redirections into effect.

GroupWise-specific 
Web Services page: 

http://web_server_address/gw/index.html

WebAccess: http://web_server_address/gw/webacc

WebPublisher: http://web_server_address/gw/webpub
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Netscape Enterprise Server for NetWare

For redirection instructions, search the Novell Support Web site (http://www.novell.com/support).

9.2.7  Web Server File Cleanup Because of a URL Change

As part of the change from /servlet/webacc to /gw/webacc, the WebAccess Installation program 
installs the WebAccess Application files into the servlet container (gw) but it does not remove old 
servlet and htdoc files located under the ROOT container of the servlet and the Web server. 
Therefore, you might want to manually delete the following directories and files:

sys:\apache2\htdocs\com
sys:\apache2\htdocs\index.html (if customized for GroupWise)
sys:\apache2\htdocs\novell.html (if index.html was not customized)
sys:\tomcat\4\webapps\ROOT\WEB-INF\classes\com
sys:\tomcat\4\webapps\ROOT\WEB-INF\lib\ldapfilt.jar
sys:\tomcat\4\webapps\ROOT\WEB-INF\lib\ldapjdk.jar
sys:\tomcat\4\webapps\ROOT\WEB-INF\lib\njgwap.jar
sys:\tomcat\4\webapps\ROOT\WEB-INF\lib\njweb.jar
sys:\tomcat\4\webapps\ROOT\WEB-INF\lib\SpellServlet.jar
sys:\tomcat\4\webapps\ROOT\WEB-INF\web.xml

You should definitely delete web.xml, because it might cause the WebAccess, WebPublisher, and 
Monitor Applications to run in both the old and new locations. Also, if you have customized the 
GroupWise template files, you should copy the contents of the template subdirectories under:

sys:\tomcat\4\webapps\ROOT\WEB-INF\classes\com\novell

to the corresponding templates subdirectories under:

sys:\tomcat\4\webapps\gw\WEB-INF\classes\com\novell

9.2.8  Problem Downloading Large Attachments

On NetWare 6.5 Support Pack 5, you might need to install a Winsock patch that enables users to 
download large attachments when they are using SSL connections to WebAccess. For a workaround, 
see TID 10100680 in the Novell Support Knowledgebase (http://www.novell.com/support/
supportcentral).

9.2.9  Memory Problem

On NetWare 6.5 Support Pack 5, you might receive one of the following error messages on the 
server where the WebAccess Agent is running:

Server logical address space is running low ...
Short term memory allocator is out of memory ...
Cache memory allocator out of available memory ...

A patch for this problem is available in TID 2973639 in the Novell Support Knowledgebase (http://
www.novell.com/support/supportcentral).
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9.2.10  Security Issue with WebAccess and Internet Explorer 5.0

When using Internet Explorer 5.0 to view messages through WebAccess, URLs to messages become 
part of the History cache and can be read by other users who have access to the same workstation. 
For solutions to this problem, see TID 10056452 in the Novell Support Knowledgebase (http://
www.novell.com/support/supportcentral).

9.2.11  Viewer Agent Issues on NetWare

On NetWare, the Viewer Agent requires at least 1 GB of memory for running about 5 worker 
processes. By default, 5 processes are started.
On NetWare, you must install the latest Support Pack for your version of NetWare in order to 
have the correct version of clib.nlm. 
On NetWare, Memory Protection Fault Cleanup must be set to On in order for the Viewer 
Agent worker processes to recover successfully when a document fails HTML conversion.
On NetWare, when a document fails HTML conversion and its worker process dies, NetWare 
creates a small file named core*.dmp in the server’s root directory. You should periodically 
delete these files.

9.3  Linux WebAccess Issues
“WebAccess on SUSE Linux Enterprise Server 10” on page 27
“Novell Distribution of Apache and Tomcat” on page 27
“Prolonged “Please Wait” Message during Installation” on page 28
“Installation Security” on page 28
“Reinstallation Issue” on page 29
“--httpport Switch Not Listed in webac70a.waa File” on page 29
“Viewer Agent Issues on Linux” on page 29
“WebPublisher Configuration” on page 29
“Commented Lines in Configuration Files” on page 29
“WebAccess Client Help Displays Incorrectly in Firefox on Linux” on page 30

9.3.1  WebAccess on SUSE Linux Enterprise Server 10

SUSE Linux Enterprise Server 10 uses Tomcat 5 rather than Tomcat 4. It also uses the 
MOD_PROXY module rather than the MOD_JK connector. Installation instructions that 
compensate for these differences are available in TID 3248145 in the Novell Support 
Knowledgebase (http://www.novell.com/support/supportcentral). 

9.3.2  Novell Distribution of Apache and Tomcat

GroupWise 7 on Linux includes a Novell distribution of Apache and Tomcat that you can install 
along with the WebAccess Application if you do not already have Apache and Tomcat running on 
that server. The Novell distribution relies on OpenSSL libraries. If OpenSSL is not already installed 
on the server where you plan to install the Novell distribution of Apache and Tomcat, you can obtain 
it from the OpenSSL Project (http://www.openssl.org). Download and build OpenSSL for your 
version of Linux before installing the Novell distribution of Apache and Tomcat.
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The Novell distribution is installed in the following directories:

It is started by using the following customized commands:

The WebAccess Installation program lets you choose whether you want to install the Novell 
distribution. During installation, select Install WebAccess Application with Apache and Tomcat if 
you want to install the Novell distribution. Select Install WebAccess Application if you do not want 
to install the Novell distribution of Apache and Tomcat because you have an existing Apache and 
Tomcat installation that you want to use with WebAccess.

NOTE: If you are installing on Novell Open Enterprise Server (OES), the option to install with 
Apache and Tomcat is not available.

If you install the Novell distribution on a server where a standard distribution of Apache and Tomcat 
is already installed and running, you will encounter a port conflict on port 80. You can resolve the 
port conflict by choosing to run one distribution or the other, or you can reconfigure one distribution 
or the other.

To reconfigure the Novell distribution to use a different port number, edit the httpd.conf file in the 
/etc/opt/novell/httpd/conf directory. Locate the following line:

Listen 80

Change the port number to a something that is not already being used on the server, then save and 
exit the file.

9.3.3  Prolonged “Please Wait” Message during Installation

On slower Linux machines, if you select Install WebAccess Application with Apache and Tomcat, 
your machine might appear to hang on the “Please Wait” message. Apache and Tomcat are being 
installed while the “Please Wait” message is displayed, before the WebAccess Application 
installation begins.

9.3.4  Installation Security

During installation, the Linux WebAccess Installation program requires access to eDirectory by way 
of LDAP authentication. The LDAP Group object includes an option named Require TLS for Simple 
Binds with Password, which is enabled by default. With this option enabled, you must provide the 
LDAP server’s trusted root certificate, which must be exported from the LDAP server, in order for 
LDAP authentication to take place (typically on port 636) during installation of the WebAccess.

Apache: /var/opt/novell/http and 
/etc/opt/novell/http

Tomcat: /var/opt/novell/tomcat4 and 
/etc/opt/novell/tomcat4

Tomcat: /etc/init.d/novell-tomcat4 start

Apache: /etc/init.d/novell-httpd start
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Unless you already have SSL set up, an easier alternative is to disable Require TLS for Simple Binds 
with Passwords in ConsoleOne, which allows LDAP authentication to take place using clear text 
(typically on port 389), during installation of WebAccess. After disabling the option, restart 
eDirectory, install WebAccess, then re-enable Require TLS for Simple Binds with Password and 
restart eDirectory again.

9.3.5  Reinstallation Issue

If you install Linux WebAccess in an eDirectory context where the WebAccess objects already exist, 
a message informs you that you can “use the existing objects.” In actuality, the objects are deleted 
and re-created, so if you have customized the properties of the existing objects, you must customize 
the objects again after installing WebAccess on Linux. 

9.3.6  --httpport Switch Not Listed in webac70a.waa File

The -httpport switch has been added to the Linux WebAccess Agent to specify the port number for 
HTTP communication. However, it is currently not listed in the webac70a.waa file on Linux.

9.3.7  Viewer Agent Issues on Linux

On Linux, if you run the Viewer Agent as a user that is not running The X Window system, 
then WebAccess client users cannot view embedded vector-based graphics in attachments. To 
enable users to view embedded vector-based graphics, make sure that the user that starts 
WebAccess (and hence, the Viewer Agent) is running The X Window System and has a 
DISPLAY environment variable set so that the Viewer Agent can write to the local display. One 
way to accomplish this is to use the sux command to become root before you start the 
WebAccess Agent.
On Linux, the third-party viewer software used by the Viewer Agent has a dependency on 
libXm.so.1, which might not be included with your Linux package. To resolve this, create a 
symbolic link in the agents lib directory to the version of the libXm modules that is available 
on your Linux server. For example:
ln -s /usr/X11R6/lib/libXm.so.3.0.1 /opt/novell/groupwise/
                                               agents/lib/libXm.so.1

9.3.8  WebPublisher Configuration

The WebAccess Installation program does not configure WebPublisher for you. Some manual 
configuration is required. For instructions, see the GroupWise 7 Installation Guide (/docs/us/
GroupWiseInstallationGuide.pdf).

9.3.9  Commented Lines in Configuration Files

If you have commented out any lines in the Linux WebAccess configuration file (webacc.cfg) or 
the WebPublisher configuration file (webpub.cfg), you should back up those files before installing 
GroupWise 7. If you use the Configure WebAccess Application option in the Installation program, 
those commented lines become uncommented and the settings return to their defaults. However, any 
other changes you have made to the configuration files are retained. You must comment out the lines 
again and edit the settings as needed, using the backup copies for reference.
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9.3.10  WebAccess Client Help Displays Incorrectly in Firefox on Linux

In Firefox on Linux, the horizontal scroll bar in the left panel of the WebAccess client help displays 
in the middle of the column instead of at the bottom. It does not interfere with help functionality.

10  Internet Agent Issues
Section 10.1, “General Internet Agent Issues,” on page 30
Section 10.2, “NetWare/Windows Internet Agent Issues,” on page 30
Section 10.3, “Linux Internet Agent Issues,” on page 31

10.1  General Internet Agent Issues
“/copyonly Startup Switch Doesn’t Update the Database Version” on page 30
“Address Resolution Change Since GroupWise 6” on page 30

10.1.1  /copyonly Startup Switch Doesn’t Update the Database Version

If you use the /copyonly startup switch on the Internet Agent Installation program to install 
GroupWise 7 Internet Agent software from a Support Pack to update original GroupWise 7 
software, the database version on the GWIA object is not updated. As a result, the Support Pack 1 
enhancement described in “Consolidated Configuration Information” in “What’s New in GroupWise 
7” in the GroupWise 7 Installation Guide (http://www.novell.com/documentation/gw7) does not 
occur. Therefore, you should not use the /copyonly startup switch when updating an existing Internet 
Agent installation to a GroupWise 7 Support Pack.

10.1.2  Address Resolution Change Since GroupWise 6

In GroupWise 6 and its Support Packs, there was a problem with the address format used for sending 
to distribution lists and resources if you set Internet Addressing to one of the following formats 
(which are not appropriate for distribution lists and resources):

first_name.last_name@Internet_domain
last_name.first_name@Internet_domain

Messages to distribution lists and resources were initially undeliverable and were sent to the Internet 
Agent. The Internet Agent then successfully resolved the addresses and sent the messages back into 
the GroupWise system. Users did not notice the problem, but some administrators noticed 
unnecessary traffic through the Internet Agent.

In GroupWise 6.5, the address format problem for sending to distribution lists and resources was 
corrected. However, users who originally used GroupWise 6 have the erroneous address format for 
distribution lists and resources in their Frequent Contacts address books. If you are updating from 
GroupWise 6 to GroupWise 7 and unnecessary traffic through the Internet Agent is a continuing 
problem, have users delete distribution lists and resources from their Frequent Contacts address 
books so that the correct address format is used for name completion in the future.

10.2  NetWare/Windows Internet Agent Issues
None.
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10.3  Linux Internet Agent Issues
“Obsolete grpwise-ia Script” on page 31
“Installation Security” on page 31
“libXm.so.3 Error” on page 31

10.3.1  Obsolete grpwise-ia Script

GroupWise 6.5 included the /etc/init.d/grpwise-ia script for starting and stopping the Linux 
Internet Agent. In GroupWise 7, the Internet Agent is started along with the POA and the MTA, 
using the grpwise script. Therefore, you should delete the obsolete grpwise-ia script from /etc/
init.d so that it is not used inadvertently.

10.3.2  Installation Security

During installation, the Linux Internet Agent Installation program requires access to eDirectory by 
way of LDAP authentication. The LDAP Group object includes an option named Require TLS for 
Simple Binds with Password, which is enabled by default. With this option enabled, you must 
provide the LDAP server’s trusted root certificate, which must be exported from the LDAP server, 
in order for LDAP authentication to take place (typically on port 636) during installation of the 
Internet Agent.

Unless you already have SSL set up, an easier alternative is to disable Require TLS for Simple Binds 
with Passwords in ConsoleOne, which allows LDAP authentication to take place using clear text 
(typically on port 389), during installation of the Internet Agent. After disabling the option, restart 
eDirectory, install the Internet Agent, then re-enable Require TLS for Simple Binds with Password 
and restart eDirectory again.

10.3.3  libXm.so.3 Error

If you try to start the Linux Internet Agent using the --show switch on a server where The X Window 
System and Open Motif are not running, you receive the following error:

libXm.so.3: cannot open shared object file
: no such file or directory

To resolve the error, start The X Window System and Open Motif before starting the Internet Agent 
with the --show switch. If you start the Internet Agent without the --show switch, you can use the 
Internet Agent Web console to monitor the Internet Agent from your Web browser.

11  Monitor Issues
Section 11.1, “General Monitor Issues,” on page 31
Section 11.2, “Windows Monitor Issues,” on page 32
Section 11.3, “Linux Monitor Issues,” on page 33

11.1  General Monitor Issues
“Problem Starting GroupWise Monitor” on page 32
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“Restoring Monitor Settings after Reinstallation” on page 32
“Monitor Agent SSL Configuration” on page 32

11.1.1  Problem Starting GroupWise Monitor

If the location of the Monitor template files is inadvertently changed, then you cannot start 
GroupWise Monitor. To resolve the problem:

1 Locate the gwmonitor.cfg file.
The location of the Monitor configuration file varies by platform:

2 Locate the Templates.Path line and correct the path as needed.
The location of the template files varies by Web server platform:

3 In ConsoleOne, browse to and right-click the GroupWiseMonitor object, then click Properties.
4 Click Application > Templates.
5 In the Template Path field, correct the path as needed, then click OK. 

When the correct template path has been supplied in the gwmonitor.cfg file and on the 
GroupWiseMonitor object in ConsoleOne, you should be able to start GroupWise Monitor.

11.1.2  Restoring Monitor Settings after Reinstallation

Monitor settings are stored in the monitor.xml file in the Monitor installation directory. Agent 
groups are also stored in this file. If you reinstall the Monitor software, the monitor.xml file is 
backed up as monitor.001. To restore previous Monitor settings and agent groups, remove the 
newly installed monitor.xml file and rename monitor.001 to monitor.xml.

11.1.3  Monitor Agent SSL Configuration

If you want to enable SSL by using the Monitor Agent /httpssl and /httpcertfile switches, the 
certificate file must be in PEM format. This differs from the other GroupWise agents, which use a 
.b64 public certificate file and a .key private key file. The PEM format combines the certificate 
and key in a single file.

11.2  Windows Monitor Issues
“New NetWare and Windows Monitor URLs” on page 33

Linux: /opt/novell/groupwise/monitor

Windows: \novell\gwmonitor

Apache on 
Linux:

/var/opt/novell/gwmon/WEB-INF/classes/com/novell/
                                    gwmonitor/templates

Apache on 
NetWare:

\tomcat\4\webapps\gw\WEB-INF\classes\com\novell\
                                    GWMonitor\templates
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11.2.1  New NetWare and Windows Monitor URLs

If you’ve used Monitor on a NetWare or Windows Web server, you are accustomed to accessing the 
following URLs:

Starting in GroupWise 7, use the following URLs on NetWare and Windows Web servers:

To keep users’ browser bookmarks from being broken, you should redirect the old URLs to the new 
URLs. Follow the instructions in Section 9.2.6, “New NetWare and Windows WebAccess URLs,” 
on page 24, substituting /gw/gwmonitor for /gw/webacc as needed in the instructions.

11.3  Linux Monitor Issues
“Linux Update Error” on page 33
“Monitor Issues Shared with WebAccess” on page 33

11.3.1  Linux Update Error

If you have installed interim releases of Monitor between Support Pack 1 and Support Pack 2, and if 
you are installing Monitor on a server where other GroupWise agents are also running, you might 
receive the following error message:

Install failed for an unknown reason (8)

To work around this error message:

1 In a terminal window, uninstall the Monitor Application by using the following command:
rpm -ev --justdb novell-groupwise-monitor

This command removes the Monitor Application from the RPM database so that it does not 
interfere with the installation of the other GroupWise components on the server.

2 In the GroupWise Installation program, update the other GroupWise components on the server.
3 Reinstall the Monitor Application individually, and do not select the Configure option in the 

GroupWise Installation program.

11.3.2  Monitor Issues Shared with WebAccess

Monitor and WebAccess share a substantial amount of functionality. The following WebAccess 
issues also pertain to Monitor:

Section 9.3.1, “WebAccess on SUSE Linux Enterprise Server 10,” on page 27
Section 9.3.2, “Novell Distribution of Apache and Tomcat,” on page 27
Section 9.3.3, “Prolonged “Please Wait” Message during Installation,” on page 28

Web Services page: Default index.html file of Web server

Monitor Web Console: http://web_server_address/servlet/gwmonitor

GroupWise-specific Web 
Services page:

http://web_server_address/gw/index.html

Monitor Web Console: http://web_server_address/gw/gwmonitor
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Section 9.3.4, “Installation Security,” on page 28
Section 9.3.5, “Reinstallation Issue,” on page 29

12  International Issues
Section 12.1, “General International Issues,” on page 34
Section 12.2, “NetWare/Windows International Issues,” on page 36
Section 12.3, “Linux International Issues,” on page 36

12.1  General International Issues
“Default MIME Encoding Change” on page 34
“Double-Byte Characters in Directory Names and Filenames” on page 35
“Double-Byte Characters in Passwords” on page 35
“Character Encoding in WebAccess” on page 35
“WebAccess Spell Checker Displays Corrupt Characters for Russian” on page 36
“WebAccess Attachments with Extended Characters in the Filenames” on page 36

12.1.1  Default MIME Encoding Change

After GroupWise 7 Support Pack 1, the GroupWise client started using UTF-8 instead of ISO for 
MIME encoding. This causes occasional problems in some languages where GroupWise 6.5 clients 
are being run against GroupWise 7 post offices. To help with the transition, a Support option has 
been added to GroupWise Check (GWCheck) to convert user databases back to the ISO encoding 
for your language.

1 Start GWCheck as described in GroupWise Check in Databases in the GroupWise 7 
Administration Guide (http://www.novell.com/documentation/gw7).

2 Under Database Type, select Post Office.
3 In the Database Path field, browse to and select the post office directory.
4 Under Object Type, select User/Resource.

If you want to perform the conversion on all user and resource databases in the post office, 
specify ALL in the User/Resource field.

5 In the Action drop-down list, select Reset Client Options.
6 In the Support Options field on the Misc tab, type setmimeencoding=number, where number 

is one of the following character set numbers:
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7 Click Run to perform the conversion of user and resource databases from UTF-8 to the selected 
character set.

12.1.2  Double-Byte Characters in Directory Names and Filenames

Do not use double-byte characters in directory names and filenames.

12.1.3  Double-Byte Characters in Passwords

Do not use double-byte characters in user passwords. 

The Change GroupWise Password dialog box in ConsoleOne currently allows entry of double-byte 
characters. However, the GroupWise client login does not allow entry of double-byte characters in 
passwords, so a user who was assigned a password with double-byte characters in ConsoleOne 
cannot type the double-byte characters when attempting to log in to GroupWise.

12.1.4  Character Encoding in WebAccess

Auto-detection of character encoding for the WebAccess/WebPublisher index.html page does not 
work for some Web browsers. If you do not see the localized languages in the drop-down menu on 
the Web services page (index.html), set your Web browser’s character encoding to UTF-8. In 
some browsers, you can click View > Encoding to set the Web browser’s encoding.

Character 
Set Number Language

1 Windows default

2 ISO default

7 Arabic (Windows 1256)

9 Baltic (Windows 1257)

12 Central European (Windows 1250)

13 Chinese Simplified (GB2312)

15 Chinese Traditional (Big5)

18 Cyrillic (K018-R)

27 Hebrew (Windows 1255)

29 Japanese (ISO2022-JP)

30 Japanese (Shift-JIS)

32 Korean (EUC-KR)

33 Thai (Windows 874)

35 Turkish (Windows 1254)

3 UTF-8
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You might also encounter character encoding problems when reading HTML-formatted messages. 
In this case, set your Web browser’s character encoding for the new message window to UTF-8. You 
can do this by right-clicking in the new message window and then setting the encoding, or by 
clicking View > Encoding.

12.1.5  WebAccess Spell Checker Displays Corrupt Characters for Russian

When Russian characters are used, they are displayed in the Spell Checker as corrupt characters.

12.1.6  WebAccess Attachments with Extended Characters in the Filenames

On Windows, Mozilla*-based browsers such as Firefox and Netscape* do not save extended 
character filenames correctly, even though the filename displays correctly in the Save As dialog box. 
This is a browser problem, not a GroupWise problem. There is no workaround.

In Safari* on Macintosh, extended character filenames are not interpreted correctly. As a 
workaround, use Firefox instead of Safari if you receive attachments with extended character 
filenames. This is a browser problem, not a GroupWise problem. 

12.2  NetWare/Windows International Issues
“Print Calendar Language” on page 36
“Japanese Viewers for WebAccess” on page 36

12.2.1  Print Calendar Language

The GroupWise client Print Calendar feature always prints calendars in the language specified in 
Regional Options or Regional Settings in the Control Panel, even if the client is installed in a 
different language. For example, if French (Switzerland) or French (Swiss) is specified in the 
Control Panel and the client is installed in German, calendars print in French.

12.2.2  Japanese Viewers for WebAccess

In the WebAccess client running on Japanese Windows XP, some characters might not display 
correctly.

12.3  Linux International Issues
“Display Problem with Agent Console Interfaces” on page 36
“Russian Keyboard” on page 37
“Mnemonics for Arabic, Hebrew, and Double-Byte Languages” on page 37
“Localized Agent User Interface Display” on page 37

12.3.1  Display Problem with Agent Console Interfaces

If you run the Linux GroupWise agents with an agent console interface in languages other than 
English, logging information might not display correctly. The problem occurs if your language 
encoding is set to UTF-8.

To determine your current language encoding, use the following command in a terminal window:
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locale

You can change your language encoding in YaST:

1 Start YaST, click System, then double-click Choose Language.
2 Select the language you are running the agents in, then click Details.
3 Deselect Use UTF-8 Encoding, then click OK.
4 Stop and then restart the agents to put the new setting into effect.

12.3.2  Russian Keyboard

When you use a Russian keyboard, the Linux environment variables that provide language and 
locale information are typically set to ru_RU. Typically, this setting implies the Russian character 
set ISO-8859-5. However, on some distributions of Linux, the ISO-8859-5 character set must be set 
explicitly in order for your Russian keyboard to work with the GroupWise Cross-Platform client. 
Use the following command to specify the character set along with the language and locale 
information:

export LANG=ru_RU.ISO-8859-5

In most cases, setting the LANG environment variable also sets all LC_* environment variables and 
resolves all Russian keyboard problems. If you set the LANG environment variable and your 
Russian keyboard still does not work, use the following command to view the current settings for 
the LANG and LC_* environment variables:

locale

If any of the LC_* environment variables have not inherited the ISO-8859-5 specification, export 
them individually.

12.3.3  Mnemonics for Arabic, Hebrew, and Double-Byte Languages

Keyboard mnemonics for menu items work for characters a-z and A-Z, but not for other characters.

12.3.4  Localized Agent User Interface Display

The Linux GroupWise agent user interfaces display correctly if the Linux environment is using the 
ISO-8859-1 character set, which is the default for the GroupWise administration languages and 
locales.

French: fr_FR
German: de_DE
Portuguese: pt_BR
Spanish: es_ES

If the Linux environment is using a different character set encoding such as UTF-8 (for example, 
fr_FR.UTF-8), the localized agent user interfaces do not display correctly.

13  Documentation Issues
Section 13.1, “General Documentation Issues,” on page 38
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Section 13.2, “NetWare/Windows Documentation Issues,” on page 38
Section 13.3, “Linux Documentation Issues,” on page 38

13.1  General Documentation Issues
None.

13.2  NetWare/Windows Documentation Issues
“GroupWise Windows Client Help” on page 38
“WebAccess/WebPublisher Help on a UNIX Web Server” on page 38

13.2.1  GroupWise Windows Client Help

To support accessibility requirements within GroupWise Help, the Help for the GroupWise 
Windows client uses Microsoft HTML Help. In order for Microsoft HTML Help to display on a 
Windows workstation, the workstation must have Internet Explorer 4.x or later installed.

13.2.2  WebAccess/WebPublisher Help on a UNIX Web Server

If you install the WebAccess Application and the WebPublisher Application on a UNIX* Web 
server, as described in “Completing the Installation on a UNIX Apache Web Server in Installing 
GroupWise WebAccess” in the GroupWise 7 Installation Guide (http://www.novell.com/
documentation/gw7), you now need to install the WebAccess and WebPublisher help files manually.

After installing the WebAccess Application and the WebPublisher Application:

1 Change to the gw/com/novell/webaccess directory of the Web server.
2 Unzip the  __help__.zip file.
3 Change to the gw/com/novell/webpublisher directory of the Web server.
4 Unzip the  __help__.zip file.

Online help is now available for WebAccess and WebPublisher users.

13.3  Linux Documentation Issues
“Agent Help Does Not Display When GroupWise Agents Run as a Non-root User” on page 38
“Help Image Display on an iChain Server” on page 39

13.3.1  Agent Help Does Not Display When GroupWise Agents Run as a Non-root 
User

When you start the Linux POA, the Linux MTA, and the Linux Internet Agent using the --show 
switch to display a GUI user interface, if the agents are running as a non-root user, clicking Help 
does not display the agent help file. Help is displayed in a browser window and the agents currently 
launch the browser as root. Giving the user access to the browser window as root would be a 
security risk. This is working as designed.
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13.3.2  Help Image Display on an iChain Server

If you display help from an agent Web console on a server where Novell iChain® is installed, and if 
iChain is configured to use the Path-Based Multihoming option, the image at the top of the help 
topic does not display.

14  GroupWise Bug Fixes
For a list of the bugs that have been fixed in GroupWise 7 Support Pack 4, see the GroupWise 7 
Support Pack 4 Bug List (http://www.novell.com/documentation/gw7/gw7sp4_fixes/data/
gw7sp4_fixes.html). You can look up the bug numbers in Bugzilla (https://bugzilla.novell.com) for 
more information about each bug

15  GroupWise Connector for Outlook
For installation instructions, known issues, and bug fixes relating to the GroupWise Connector for 
Microsoft Outlook, see the Support Pack 1 Readme for the GroupWise Connector for Microsoft on 
the GroupWise 7 Documentation Web site (http://www.novell.com/documentation/gw7).

16  GroupWise Mobile Server
For installation instructions, known issues, and bug fixes relating to GroupWise Mobile Server, 
Powered by Intellisync*, see the Support Pack 1 Readme for GroupWise Mobile Server on the 
GroupWise 7 Documentation Web site (http://www.novell.com/documentation/gw7).

17  Bug Fixes
For a list of the bugs that have been fixed in GroupWise 7 Support Pack 4, see the GroupWise 7 
Support Pack 4 Bug Fix List (http://www.novell.com/documentation/gw7/resources/
GW704_Fixes.html).

18  Documentation
All GroupWise 7 documentation is available on the GroupWise 7 Documentation Web site (http://
www.novell.com/documentation/gw7).

In addition to the GroupWise product documentation, the following resources provide additional 
information about GroupWise 7:

Novell Support and Knowledgebase (http://www.novell.com/support) 
GroupWise Support Forums (http://forums.novell.com/novell-product-support-forums/
groupwise) 
GroupWise Cool Solutions (http://www.novell.com/communities/coolsolutions/gwmag) 

19  Documentation Conventions
In this documentation, a greater-than symbol (>) is used to separate actions within a step and items 
in a cross-reference path.
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A trademark symbol (®, TM, etc.) denotes a Novell trademark; an asterisk (*) denotes a third-party 
trademark

20  Legal Notices
Novell, Inc. makes no representations or warranties with respect to the contents or use of this 
documentation, and specifically disclaims any express or implied warranties of merchantability or 
fitness for any particular purpose. Further, Novell, Inc. reserves the right to revise this publication 
and to make changes to its content, at any time, without obligation to notify any person or entity of 
such revisions or changes.

Further, Novell, Inc. makes no representations or warranties with respect to any software, and 
specifically disclaims any express or implied warranties of merchantability or fitness for any 
particular purpose. Further, Novell, Inc. reserves the right to make changes to any and all parts of 
Novell software, at any time, without any obligation to notify any person or entity of such changes.

Any products or technical information provided under this Agreement may be subject to U.S. export 
controls and the trade laws of other countries. You agree to comply with all export control 
regulations and to obtain any required licenses or classification to export, re-export, or import 
deliverables. You agree not to export or re-export to entities on the current U.S. export exclusion 
lists or to any embargoed or terrorist countries as specified in the U.S. export laws. You agree to not 
use deliverables for prohibited nuclear, missile, or chemical biological weaponry end uses. Please 
refer to the Novell International Trade Services Web page (http://www.novell.com/info/exports/) for 
more information on exporting Novell software. Novell assumes no responsibility for your failure to 
obtain any necessary export approvals.

Copyright © 2010 Novell, Inc. All rights reserved. No part of this publication may be reproduced, 
photocopied, stored on a retrieval system, or transmitted without the express written consent of the 
publisher.

For Novell trademarks, see the Novell Trademark and Service Mark list (http://www.novell.com/
company/legal/trademarks/tmlist.html).

All third-party trademarks are the property of their respective owners.
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